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Download the file Data Source from here.

 
Mail Merge from Scratch 

 

In this guide you will start a Mail Merge from scratch using a blank 
document. But you can also use an existing letter or other business 
document.  

Also, you can use the step-by-step Mail Merge Wizard to guide you 
through the Mail Merge process or you can use the tools on the 
MAILINGS tab to perform a manual Mail Merge.  

 

 

https://sgul365-my.sharepoint.com/:x:/g/personal/fgraham_sgul_ac_uk/EWhuUrahhtNImadGQXotfOABayRA5x_lE9bTL5fZh_dWpg?e=YD5C3T
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UNDERSTANDING MERGING FROM SCRATCH 
 

 

 

 

  

 

You use Mail Merge when you want to send the 
same document to many people. For instance, 
you may need to send a letter to all your clients 
advising them of your new address or opening 

hours. While you can use the Mail Merge Wizard 
to guide you through the Mail Merge process, you 
can also use the Mailings tab to perform a manual 
Mail Merge from scratch.  
 

Begin the Mail Merge Process 

Though Word has made performing a Mail Merge very quick and easy with the provision of the Mail Merge 
Wizard, there are times when you may need to perform a Mail Merge from scratch. Performing a Mail Merge 
from scratch means you have a bit more control over what you are doing and access to some more advanced 
features. Word makes performing a Mail Merge from scratch easy by providing the Mailings tab which sets 
out each stage of the process sequentially from left to right with the appropriate tools for each stage. 

The Starting Document 

The first group on the Mailings tab is the Create group and from here you can select what type of Starting 
Document to use. Alternatively if you need more options you can select Start Mail Merge in the Start Mail 
Merge group. 

The first step in creating a Mail Merge document requires you to select the type of document you want to 
create. For instance, you can: 

• send letters or any other type of business document to a group of people 

• print addressed envelopes or labels for a group mailing 

• create and print a single document comprising a catalogue (such as the name and description of 
products) or a directory of addresses. 

This document is called the main document. The main document can be an existing document you open 
before you start the merge, or the document that is currently active in Word. 

Select Recipients 

The next step in the Mail Merge process is to connect the main document to the data source file commonly 
known as the recipient list.  

The second group on the Mailings tab is the Start Mail Merge group and from here you can use several 
commands to either choose, create or edit a recipient. This file contains the recipients’ information, such as 
names and addresses. You can use an existing file (such as a table created in a Word document or a client 
database in Access), your Outlook contacts list, or create a recipient list during this step of the merge process. 

Finalise the Main Document 

Once you have connected the main document to the data source file, you are ready to finalise the main 
document, which includes typing the content of the document, as well as inserting Mail Merge fields. 

To do this you can use the Write & Insert Fields group on the Mailings tab which allows you to do all sorts of 
things.  Mail Merge fields indicate to Word where the recipient data should be inserted based on the name of 
the fields. The name of the Mail Merge field must correspond to the field headings in the recipient list so 
Word knows what type of data to insert.  

To save time when creating the main document, Word has included the combination fields: 
<<AddressBlock>> and <<GreetingLine>>.These fields allow you to select, format and insert multiple fields 
such as the First Name, Surname, Address, City, Postcode, and so on into the main document as a single 
field, rather than inserting each mail merge field individually. 

Preview the Results 

Once you have created the main document and inserted the relevant Mail Merge fields, you can preview each 
Mail Merge document using the Preview Results group on the Mailings tab. For example, a preview of the 
document to be sent out to Recipient 1 will appear — all Mail Merge fields will have been replaced by the 
corresponding data from the recipient list in the data source file. You can preview the Mail Merge document 
for each recipient to ensure the process has worked properly, as well as check for any formatting or layout 
issues. It’s always a good idea to preview the main merge document. 

Perform the Mail Merge 

When you perform the Mail Merge you can either merge to a new document to save and personalise the 
documents as required, or send the Mail Merge documents directly to a printer. To do this simply use the 

Finish group on the Mailings tab. 
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SELECTING THE DOCUMENT TYPE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3 

The first step of the Mail Merge process involves 
selecting the main document based on the type 
of document you want to create. For example, 
you may be creating a letter to distribute to 

clients or send emails for a bulk mail out. Selecting 
the document type means the document will be 
created in the required layout with some formatting 
already completed to help save time. 
 

Try This Yourself: 

 

Before starting this 
exercise ensure you 
have a blank document 
open... 

 Click on the Mailings 
tab  

The Mailings tab 
includes all options for 
completing a Mail 
Merge. Let’s select the 
type of document to set 
up as the main 
document... 

 Click on Start Mail 
Merge in the Start Mail 
Merge group to display 
a list of document types 
and merge options 

 Select Letters 

Nothing appears to have 
happened but the blank 
document is now the 
main document, ready 
for you to type the letter. 

Leave the document 
open for the next 
exercise 

 

1 

2 

For Your Reference… 

To select the document type: 

1. Click on the Mailings tab, then click on Start 
Mail Merge in the Start Mail Merge group 

2. Select the desired document or merge type 

Handy to Know… 

• If you have selected the wrong document 
type as the main document, you can revert it 
back to a normal Word document. To do this, 
click on the Mailings tab, then click on Start 
Mail Merge in the Start Mail Merge group 
and select Normal Word Document. 
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SELECTING THE RECIPIENTS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

       

Recipient data, such as names and addresses 
must be stored in a separate file in a tabular 
format with columns and rows, such as an Excel 
spreadsheet, Access database or a table in a 

Word document. This data file, or data source, 
must be linked to the starting document so Word 
knows what fields (headings) are available, as well 
as where the merge data is stored. 
 

 Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the 

previous file with this 
exercise... 

 If necessary click on the 
Mailings tab, then click 
on Select Recipients in 
the Start Mail Merge 
group to display a menu 
of options 

 Select Use an Existing 
List to open the Select 
Data Source dialog box, 
then navigate to the 
course files folder 

 Navigate to the folder 
where you saved the file, 
then click on Data 
Source, then click on 
[Open] 

Nothing appears to have 
happened but the data 
source file is now 
attached to the main 
document. 

Leave the document open 
for the next exercise 

 

1 

2 

For Your Reference… 

To select the recipients: 

1. Click on the Mailings tab, then click on 
Select Recipients in the Start Mail Merge 
group 

2. Select Use Existing List, locate and select 
the data source file, then click on [Open] 

Handy to Know… 

• If you don’t want to send the Mail Merge 
document to all recipients in the data source, 
you can exclude recipients. To do this, click 
on Edit Recipient List in the Start Mail 
Merge group and click on the tick box beside 
the recipient name(s) you want to exclude 
until it appears without a tick. 

Link to download file Data Source 

https://sgul365-my.sharepoint.com/:x:/g/personal/fgraham_sgul_ac_uk/EWhuUrahhtNImadGQXotfOABayRA5x_lE9bTL5fZh_dWpg?e=YD5C3T
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INSERTING THE DATE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

One of the first things you’ll do when creating a 
letter is to insert the date. Word’s Date and Time 
dialog box allows you to insert the date 
automatically in the desired format. The standard 

format for business letters is dd MM yyyy, such as 
19 April 2013. But keep in mind that your 
organisation may have a specific format you must 
apply.  
 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the 

previous file with this 
exercise... 

 Ensure the insertion point 
is at the top of the 
document, then press  

three times to insert three 
blank paragraphs 

 Click on the Insert tab, 
then click on Date & Time 
in the Text group, to open 
the Date and Time dialog 
box 

 Ensure English 
(Australia) is selected in 
Language 

 Click on the date format as 
shown to select it 

 Click on [OK] to insert the 
date into the document 

The font applied to the date 
and the position of the date 
in the document may differ 
to what is shown here, as it 
depends on the layout and 
formatting applied to the 
default (Normal) template 
on your computer. 

Leave the document open 
for the next exercise 

 

4 

For Your Reference… 

To insert the date: 

1. Click on the Insert tab, then click on Date & 
Time in the Text group 

2. Select the desired format 

3. Click on [OK] 

3 

5 

Handy to Know… 

• To set the selected date format as the default 
format for all correspondence, select the 
desired format in the Date and Time dialog 
box, click on [Set as Default], then click on 
[OK] to insert the date and apply it as the 
default format. 
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INSERTING AN ADDRESS BLOCK 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When creating mail merge fields, Word will look 
at the field headings in the data source to 
identify the mail merge fields that need to be 
inserted into the document. You can insert the 

merge fields into the main document where 
required. For the address details, though, you can 
use the Address Block combination field to insert 
the address fields as a single field.  
 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous 

file with this exercise... 

 

 Click to the right of the date 
and press  three times to 

position the insertion point 

 Click on the Mailings tab, 
then click on Address Block 
in the Write & Insert Fields 
group to open the Insert 
Address Block dialog box 

A preview of the first 
recipient’s address is shown 
in the Preview pane. 
Currently, the post code is 
missing. This means the field 
heading in the data source 
does not match the default 
Mail Merge heading. Let’s 
add it... 

 Click on [Match Fields] to 
open the Match Fields 
dialog box 

 Click on the drop arrow for 
Postal Code and select 
Postal_Code, then click on 
[OK] 

The post code now appears 
in the Preview pane… 

 Click on [OK] to insert the 
Address Block field into the 
document 

Leave the document open for 
the next exercise 

 

2 

3 

For Your Reference… 

To insert an address block: 

1. Click on Address Block in the Write & 
Insert Fields group 

2. Select the desired format for the recipient 

3. Click on [Match Fields] if necessary 

4. Click on [OK] 

5 

Handy to Know… 

• If you don’t want to use an address block, 
you can insert the address merge fields one 
by one. To do this, click on Insert Merge 
Field in the Write & Insert Fields group, 
then select the relevant field. Press  or 

, then click on Insert Merge Field to 

insert the next field, and so on. 
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INSERTING THE GREETING LINE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Greeting Line field is a combination field 
you can use to insert the salutation. The 
Greeting Line field is usually made up of the 
Title field (such as Ms or Mr) and Last name or 

Surname field. You can also format the Greeting 
Line field to your preferred format, depending on 
the level of formality that you want to convey, for 
example, ‘Dear Miss Patford’ or ‘To Kate’.  

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the 

previous file with this 
exercise... 

 Click to the right of the 
Address Block field and 
press Enter three times to 
position the insertion point 

 On the Mailings tab, click 
on Greeting Line in the 
Write & Insert Fields 
group to open the Insert 
Greeting Line dialog box 

A preview of the salutation 
for the first recipient is 
shown in the Preview pane. 
Currently, a comma 
appears at the end of the 
salutation. Let’s remove the 
comma because the most 
widely accepted layout for 
business documents is a 
fully blocked style with 
open punctuation (all 
unnecessary commas and 
full stops removed)... 

 Click on the drop arrow to 
the right of the comma box 
and select (none) as 
shown 

 Click on [OK] to accept the 
change and insert the 
Greeting Line field 

Leave the document open 
for the next exercise 

 

1 

3 

For Your Reference… 

To insert the greeting line: 

1. Click on the Mailings tab, then click on 
Greeting Line in the Write & Insert Fields 
group 

2. Set the desired Greeting line format 

3. Click on [OK] 

Handy to Know… 

• If the preview in the Preview pane of the 
Insert Greeting Line field is blank or only 
partially correct, you may need to match the 
field names. To do this, click on [Match 
Fields] then, under Required for Greeting 
Line, select the field name that corresponds 
to the Courtesy Title and Last Name. 

4 



Microsoft Word  

 Page 7 Merging From Scratch 

TYPING THE LETTER 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The next step in the Mail Merge process is to set 
up the main document, which means typing the 
text or inserting the required content into the 
document. In this case you’ll type a letter that will 

be sent out to the recipients. This step also 
includes applying any font or paragraph formatting, 
inserting headers and footers, as well as adjusting 
the page layout, if necessary.  
 

Try This Yourself: 

 Continue using the previous 
file with this exercise... 

 Click to the right of the 
Greeting Line field and 
press Enter twice 

 Type the text as shown, 
pressing Enter at the end of 
each paragraph.  

Note the following: 

• Press Enter twice after 
typing RE: Personal 
Assistant … 

• The hash symbols (#) 
indicate where the 
remaining mail merge 
fields will be inserted 

• Press Enter four times 
after sincerely, to insert 
space for the signature 

Press Shift and Enter after 
Fred Smith to insert a soft 
return 

 Select the text Re: 
Personal Assistant to the 
General Manager and 

press Ctrl + B  
to make the 

text bold 

Leave this document open 
for the next exercise 

 

For Your Reference… 

To type the letter: 

1. Click in the document and type the details as 
desired 

2. Apply any font and paragraph formatting as 
required 

3. Adjust the page layout as required 

2 

Handy to Know… 

• It is customary to end a letter in a polite way 
by using a complimentary close. The two 
most common closes are ‘Yours faithfully’ 
(used when addressing the recipient as Sir or 
Madam) and ‘Yours sincerely’ (used with 
personalised salutations such as ‘Dear 
Marie’ or ‘Dear Ms Smeetz’). 

3 
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INSERTING INDIVIDUAL MERGE FIELDS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

As part of setting up the main document, you can 
insert individual merge fields from your data 
source file. Simply click in the document at the 
location where you want the information to 

appear and then select the desired field from either 
the Insert Merge Fields drop-down menu or dialog 
box. During the merge, the values from the data 
source file will replace the mail merge field code.  
 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the 

previous file with this 
exercise... 

 Select the first hash 
symbol (#) in the second 
paragraph, but make sure 
not to select the space 
after # 

 Click on the Mailings tab, 
click on the bottom half of 
Insert Merge Field in the 
Write & Insert Fields 
group to display a list of 
available merge fields in 
the attached data source 
file 

The interview date needs 
to be inserted here... 

 Select Date 

The selected hash symbol 
will be replaced with the 
Date merge field. Let’s 
insert the time of the 
interview... 

 Repeat steps 1 to 3 to 
replace the second hash 
symbol (#) with the Time 
merge field 

Leave the document open 
for the next exercise 

 

1 

3 

For Your Reference… 

To insert merge fields: 

1. Position the cursor where you want to insert 
the merge field 

2. Click on the bottom half of Insert Merge 
Field in the Write & Insert Fields group and 
select the required merge field  

Handy to Know… 

• You cannot manually type the merge field 
characters (<< >>) or use the Symbol 
command on the Insert tab. 

• If the merge fields appear as the underlying 
field codes, such as {MERGEFIELD Time}, 
right-click on the code and select Toggle 
Field Codes to display the merge fields. 

4 
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PREVIEWING THE MERGE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

By this stage you should have finalised the main 
document, including inserting content and 
applicable merge fields, and finalised the layout 
of the document if required. Now you can preview 

the merged documents to see how they will look 
when printed or sent. At this stage you can check 
for spelling, layout and then make the required 
changes before completing the merge. 
 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous 

file with this exercise... 

 

 On the Mailings tab, click 
on Preview Results in the 
Preview Results group 

A preview of the first merged 
document, addressed to the 
first recipient will appear. At 
this point you could fix any 
layout or formatting issues.  

 Click on Preview Results 
again to return to the main 
document, then click in the 
text Yours sincerely 

 Click on the Layout tab, 
then click on for Spacing 
Before in the Paragraph 
group, until it reads 18 pt 

 Click on the Mailings tab, 
then click on Preview 
Results again to view the 
result 

Now let’s preview all the 
merged documents... 

 Click on Next Record in the 
Preview Results group to 
scroll through the records, 
then click on First Record 
to return to the first record 

Leave this document open 
for the next exercise 

 

4 

For Your Reference… 

To preview the merge: 

1. On the Mailings tab, click on Preview 
Results in the Preview Results group 

2. Click on Next Record and Previous Record 
to scroll through each merged document 

Handy to Know… 

• To preview a merged document for a 
particular recipient, click on Find Recipient  
in the Preview Results group on the 
Mailings tab. Type the text you are looking 
for in Find what, select the field in which the 
text is found in In field and click on [Find 
Next]. 

5 First Record Next Record 
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COMPLETING THE MERGE TO PRINT 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5 

When you’re ready to complete the merge, you can 
send the merged documents directly to the printer, 
edit individual letters or send via email. When you 
select the edit individual letters option, a new 

document is created that contains all the merged 
documents, each starting on a new page. If you 
have included recipients’ email addresses in the 
data source, you can email the merged document 
to each recipient. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous 

file with this exercise... 

 Click on the Mailings tab, then 
click on Finish & Merge in the 
Finish group to display a 
menu of options 

Let’s print the first merged 
document… 

 Select Print Documents to 
open the Merge to Printer 
dialog box 

 Click on Current record, as 
shown, then click on [OK] and 
click on [OK] again to print the 
first merged document 

Now let’s merge the records to 
a new document… 

 Repeat step 1 and select Edit 
Individual Documents to 
open the Merge to New 
Document dialog box 

 Click on All in Merge records, 
then click on [OK] to create a 
new document called Letters1 

Notice that the status bar 
indicates you are on ‘Page 1 
of 5’, as each letter is on a 
separate page of the 
document... 

 Click on the File tab, click on 
Close, then click on [Don’t 
Save] to close the letters 
without saving 

 

1 

2 3 

For Your Reference… 

To complete the merge: 

1. On the Mailings tab, click on Finish & Merge 
in the Finish group 

2. Select Edit individual document, then click 
on [OK] to create the letters, or 

 Select Print Documents, then click on [OK] 

Handy to Know… 

• If you have included recipients’ email 
addresses in the data source, you can email 
the merged document to each recipient. To 
do this, click on Finish & Merge and select 
Send Email Messages. Select the email 
field for To, type a Subject and select the 
preferred Mail format. Click on [OK]. 
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When you’re ready to complete the merge, you can 
e-mail the merged documents directly to everyone. 

Try This Yourself: 

 Start with a blank document 

 
Click on the Mailings tab, then click 
on Start Mail Merge, in the Start 
Mail Merge group to display a menu 
of options. Select E-mail Messages. 
 

The document window will widen 

 
Click on the Mailings tab, click on 
Select Recipients in the Start Mail 
Merge group and select Use an 
Existing List. 

 
Navigate to the course files folder, 
select Data Source.xlsx, then click 
on Open. 
Notice If you are using a Excel 
spreadsheet, you will be ask to select 
the sheet with the data. Then click 
OK. 

 Type the text as shown, pressing 

Enter  at the end of each 

paragraph.  

 
Insert the Date, Address block and 
Greeting Line. Shown in the letter 
image.  
Note: Refer to the contents page if 
needed. 

 Select the first hash # symbol. Click 
on Insert Merge Field, Select Date. 
Repeat these to replace the second 
hash with the Time merge field. Then 
preview the merge. 

 Cn the Mailings tab, click on Finish 
& Merge. Select Send Email 
Messages. 

 In the To box select E-mail. In the 
Subject line: box enter Interview. 

Then click OK. 

 

1 

2 

For Your Reference… 

To complete the merge: 

1. On the Mailings tab click on Start Mail 
Merge. Select E-mail Messages. 

2. Select recipients and place the fields where 
you want the data to appear,  

4. Preview, edit and send emails 

Handy to Know… 

• If you have included recipients’ email 
addresses in the data source, you can email 
the merged document to each recipient. To 
do this, click on Finish & Merge and select 
Send Email Messages. Select the email 
field for To, type a Subject and select the 
preferred Mail format. Click on [OK]. 

 

COMPLETING THE MERGE TO EMAIL 
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4 
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SETTING UP MAILING LABELS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Mailing labels are easy to create, particularly if 
you purchase standard mailing labels from known 
label vendors so the label dimensions match the 
corresponding codes in Word. Even if you use an 

obscure sheet of labels, you can specify the 
dimensions of the label yourself using the Label 
Options dialog box.  
 

Try This Yourself: 

 

Before starting this exercise 
you MUST ensure a blank 
document is open... 

 Click on the Mailings tab, click 
on Start Mail Merge in the 
Start Mail Merge group and 
select E-mail messages 

The screen will widen… 

 In Tray, ensure Default tray is 
selected, then in Label 
vendors select Avery A4/A5  

If you are using different labels, 
select the appropriate option… 

 Under Product number scroll 
down to and click on L783, 
then click on [OK]  

Dotted lines should appear 
showing each label on the 
page. Let’s add the recipients… 

 Click on Select Recipients in 
the Start Mail Merge group 
and select Use an Existing 
List to open the Select Data 
Source dialog box 

 Navigate to the course files 
folder, select Data 
Source.xlsx, then click on 
[Open] 

Next Record appears in all 
labels except the first, which is 
ready for you to select the 
merge fields you want to 
include in the labels. Keep this 
file open for the next exercise 

 

1 

3 

For Your Reference… 

To create mailing labels: 

1. Click on Start Mail Merge on the Mailings 
tab and select Labels 

2. Specify the label options and click on [OK] 

3. Click on Select Recipients in the Start Mail 
Merge group  

Handy to Know… 

• If you want to specify your own label 
dimensions, click on [New Label] in the 
Label Options dialog box. 

5 

If dotted lines indicating the labels don’t appear, click 
in the document and click on the Table Tools: Layout 
tab then click on View Gridlines in the Table group. 

 



Microsoft Word  

 Page 13 Merging From Scratch 

COMPLETING MAILING LABELS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Once you’ve specified the dimensions of your 
label sheets and selected the recipient list, you 
are ready to select the fields of data you want to 
include on your labels. In most instances, you will 

want to select name and address details but this 
isn’t the sole use of mailing labels. You may want 
to produce labels for stock items, name badges, 
and more.  
 

Try This Yourself: 

S
a

m
e

 

F
il

e
 Continue using the previous file 

with this exercise. 

 

A message will appear asking if 
you want to continue. Click on 
[Yes] to open the file… 

 On the Mailings tab click on the 
bottom half of Insert Merge Field 
in the Write & Insert Fields group 
to display a menu of options 

 Click on Title to insert this field, 
then press Space to insert a blank 
space after the Title field 

 Repeat steps 1 and 2 to insert the 
Surname field 

Let’s add the next line of fields… 

 Press Shift + Enter to move the 
cursor to the next line, then repeat 
the above steps to insert the 
Address field  

 Click on Update Labels in the 
Write & Insert Fields group to add 
the fields to all labels on the page 

 Click on Preview Results in the 
Preview Results group to see how 
all labels would appear if printed 

 Click on Preview Results again to 
turn off preview mode, then close 
the file without saving it  

If you want to edit and print the 
labels, click on Finish & Merge in 
the Finish group         

 

2 

5 

For Your Reference… 

To complete mailing labels: 

1. On the Mailings tab click on Insert Merge 
Field in the Write & Insert Fields group  

2. Select the fields and click on [Insert] 

3. Click on Update Labels  

4. Preview, edit and print the labels  

Handy to Know… 

• Use the options in the Write & Insert Fields 
group to control the information that is added 
to the first blank address label. For example, 
you can click on individual fields rather than 
the Address block to insert and format the 
recipient’s name and postal address details. 

6 
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CHALLENGE EXERCISE 

Getting Help 
    

 

Tasks: Completed: 

 Before starting this exercise, you MUST have completed all of the topics in 
the chapter Merging to Labels… 

 

 In the space provided on the following page describe how to start a Labels 
mail merge 

 

 On the next page describe what appears in each label area once you have 
started the merge and connected to a data source. 

 

 Explain how to add fields to all labels on a page.  

 

Files required for 
exercise: 

None 

Files/work created by 
student: 

Photocopy of the page showing completed answers 
 

Exercise Completed:  
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CHALLENGE EXERCISE SAMPLE 

Getting Help 
    

 

 

 

 

 

 

 

 

 

 

  

 

Describe how to start a Labels Mail Merge 

 ______________________________________________________________________  

 ______________________________________________________________________  

 ______________________________________________________________________  

 ______________________________________________________________________  

 ______________________________________________________________________  

What placeholder appears in each label area once you have started the merge and 
connected to a data source 

 ______________________________________________________________________  

 ______________________________________________________________________  

 ______________________________________________________________________  

 ______________________________________________________________________  

Explain how to add fields to all labels on a page 

 ______________________________________________________________________  

 ______________________________________________________________________  

 

 

 

 

 

 

 

1 

2 

3 
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CHALLENGE EXERCISE 

Merging From Scratch 
    

 

Tasks: Completed: 

 Before starting this exercise you MUST have completed all of the topics in 
the chapter Merging From Scratch… 

 

 Open a new blank document, then create a letter inserting the current date 
and using the text and mail merge fields shown below: 

Current date 

<<AddressBlock>> (ensure that you include the post code) 

<<GreetingLine>> (using no commas) 

You will have already received our formal acknowledgement of your 
order number <<Order_Number>> dated <<Date>>. But since this is 
your first order with us I felt I must write to say how pleased we were 
to receive it and to thank you for the opportunity given to us to supply 
the goods you need. 

I hope our handling of your order will lead to further business 
between us, and a happy and mutually beneficial association. 

Yours sincerely 

FRED SMITH 
Manager Customer Services 

 

 Connect the document to the data source called PE_Scratch Data 
Source.docx (it can be found in the same folder as the student files) 

 

 Preview the merged documents, then use Save As to save the document 
as PE_Merging From Scratch Preview (Completed).docx 

 

 Finalise the merge to a new document comprising all six letters, then use 
Save As to save the document as PE_Merging From Scratch 
(Completed).docx 

 

 

Files required for 
exercise: 

PE_Scratch Data Source.docx 

Files/work created by 
student: 

PE_Merging From Scratch Preview (Completed).docx and PE_Merging 
From Scratch (Completed).docx 

Exercise Completed:  
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CHALLENGE EXERCISE SAMPLE 

Merging From Scratch 
    

 

 


